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Microsoft Word for Newsletters/Flyers
Microsoft Word is a software program used to prepare documents and is part of the
Microsoft Office Suite. However, Microsoft Word may also be used for desktop
publishing as in newsletters, flyers and brochures.
Let’s begin by creating a simple newsletter. If you are going to prepare a weekly or
monthly newsletter, it is best if you create a standard banner, which you can reuse.
Open a file in Word and create a one-column banner that includes a title, date and
name of your publication. Try to insert at least 1 picture or graphic in your banner.
After you have completed the one column banner, place your cursor where you want
your second section to begin and click on Insert then on Break and select Continuous.
You can change the column formatting in the second section by clicking on Format,
then Columns and selecting what you want in the columns dialog box. You can also
use the columns icon in the formatting menu. When you begin your newsletter, you
have a choice to make re formatting your text.
You can do it ‘as you go’ or after you have entered all your text. I personally am an “as
you go” kind of person but it is up to you.
Try to put in some word art,
shapes, pictures, and
graphics so that you learn
something new as you work
on your newsletter.
You will find word art and
shapes on your Drawing
Toolbar.

“Beginning Classroom Applications for Microsoft Word” developed by Susan Gaer and
available on the Internet is an excellent source to help you find templates to use as well
as clipart and pictures.
http://ext.sac.edu/continuing_education/technology_training/wordlit.html
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Newsletter Sample

Travels With Jane
(Newsletter Text - Lucinda Sans)

Volume 1, Summer 07

Hi All. My journey has begun and
I am going to take you along with
me. Expect one of these email
newsletters to arrive in your
inbox every few weeks. If you
get tired of hearing from me or
maybe a little jealous just send
me an email to cancel and I will
not send you another or speak to
you for the rest of your life.

(Word Art)
Weather is extremely hot here but
it has not kept me secluded in my
room. I have found time to
explore the country and meet
many wonderful people. The
architecture here is truly
amazing. The buildings are

being restored as government
money is available, which often
leaves the more decrepit ones
still standing beside them as a
stark comparison.

Picture
Inserted
Change
picture
layout to
have text
wrap.

Surprisingly, you are still able to
smoke in bars and restaurants.

This gentleman was using a
homemade camera to take our
picture. He inserted a
background during the
development stage. Not quite as
professional as Photoshop but it
did the job.
Well that is all for now. Hope you
enjoyed my snaps. Will be in
touch soon.

Wish you
were here!!!!!
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Often you are sending out a flyer to advertise something that may be happening
in your classroom or your community. A catchy flyer incorporates pictures and
graphics as well as text. This will help your flyer stand out and perhaps get a
little more attention. Using many of the same features in the Newsletter design
except the columns can do this.
One of the neat features you may use is a watermark. After you have created
your flyer, click on the Insert Clipart
icon or go to the Insert Menu, under
Picture. Select any clipart you think will suit the theme of your flyer and insert it.
Once inserted you will have to manipulate it to create a watermark, behind the
text, faded and enlarged. All of these options are found in the Format Picture
dialog box, which becomes available when you click on the clipart you have
inserted.

Under the Color and Lines option, select
watermark under Image Control. It
automatically decreases the brightness and
contrast.
Under Layout, select Behind Text, which is
where you want your watermark to go.
Under Size, you can increase the size of your
watermark.
Begin working on a flyer. Try to incorporate graphics, shapes, text and a
watermark.
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Watermark Flyer

To assist you in using the Advancing Learning Technology Website:
Go to http://alt.ns.literacy.ca or http://www.ns.literacy.ca and click on the ALT
Link at the base of the lighthouse.
On the right side of the ALT web page there is a box titled login click on create
a new account.
Pick a user name and a password and complete the form *use a proper email
address, as you will be asked to check it later. Use a password you will
remember easily. Write it down.
After you click “create the account” you will be taken back to the ALT web
page. You must check your email at this time. In an email from Admin User
you will see “To confirm your new account, please go to this web address:”
click on the link provided. It should look like this
http://alt.ns.literacy.ca/login/confirm.php?p=EYIMA686R7AFvXo&s=j
The link in the email should take you to a page that states:
Your registration has been confirmed.
In the center of that page you should see you are logged in as “your name”.
click on the word “home “ and it will take you back to the ATL homepage.
You are now ready to navigate through the site. ☺ Enjoy
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Creating a PowerPoint Presentation
Microsoft PowerPoint is a software package, which has everything you need to
produce a professional looking presentation. It is part of the Microsoft Office
Suite and anything produced on Word or Excel may be imported into a
PowerPoint.
PowerPoint looks like a photographic slide show but it makes use of computers
and digital projectors to produce it. What you create, rather than a page of text,
is a slide. All the slides are linked together through transitions. The best way to
learn how to do one is to work through a simple one at first, then try inserting all
the bells and whistles.
When you open up PowerPoint, a dialog box appears, asking you to select a
method to create your presentation. Rather than being confined by
predetermined parameters, let’s select Blank Presentation. In this way your
Title Slide will appear and you may place the text within the text boxes, change
the color and change the font.
After you complete the title slide, go to Insert and select New Slide or select a
new slide from the formatting toolbar.

The new slide dialog box will appear.
Select the slide that most fits what you
want to have to insert.

Place your cursor inside the text box
and click. Now insert text and graphics
into the slides you select.
Create several slides in the same
manner.

Under Slide Show select View Slide Show to see what you have created.
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To Enhance Your PowerPoint Presentation
Under Format or on the formatting toolbar select Apply Design Template,
Background or Color Scheme. The selection will alter the entire presentation.

To enhance your presentation select Slide
Transitions under Slide Show. Now select the
transition effect between each slide, the
accompanying sound and advancement method.
After you have made your choices, select Apply
to All to make it easier. You may also do each
transition separately and select Apply after each.

Custom Animation
To further enhance your presentation,
select Custom Animation under
Slide Show.
Here you select how, when and which
order you want the components of
each of your slides, such as text and
graphics, to become visible. You can
have them flying in from all over the
place.

Create a Slide Master
This is something else you should do. Create a slide master to save time when
you are creating a PowerPoint
presentation. Any changes you make on
the master will correspondingly be made
to your entire slide show.
To do this, go to View select Master.
Begin to select formatting and font size for
your presentation.
If you want to change the basic format of
your presentation at any time, make the
changes on your master and they will be automatically transferred to all the
slides in your presentation.
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Microsoft Excel Database
Microsoft Excel is a spreadsheet application much like an old fashioned ledger.
It allows you to work with numbers and text in a grid of horizontal, numbered
rows and vertical, lettered columns. The intersection point of the columns and
rows are called cells and are named for the column letter and the row number
where they meet.
In each cell you place data, either text (label),
numbers (constant) or formulas
(mathematical equation).
The Excel window is much like Word with the
addition of one very important feature, the
Formula Bar. The name box is on the left,
containing C6.
We will look at the basics of Excel and what
we are able to do at that level.

Spreadsheets have many simple math functions such as Addition +, Subtraction , Multiplication * and Division / built into them. They follow the orders of
operations, as in Algebra. Calculations are performed from left to right, with
multiplication and division performed before addition and subtraction (MDAS).

1
2
3

A
4
10
2

B
6
5
3

Working with just these you can create many Excel
documents that may be very useful and minimize
repetition of work.

The constant data are any numbers in the cells. The referenced data, cell
allocation, will manipulate the constant data, which may vary.

Symbol
Constant
Referenced
Operation
Answer
Following these
Function Data
Data
tables, create a
Multiplication
*
=4*6
=A1* B1
24
small excel file
Division
/
=
10
/
5
=A2
/
B2
2
showing
Addition
+
=5+2
=B2 +A3
7
addition,
Subtraction
=
10
3
=A2
B3
7
subtraction,
multiplication and division, and incorporating the use of the orders of operation.
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Using the Auto Sum and the Paste Function on the standard toolbar will speed
the process. Once you have the formulas set up you can change the inputs and
the computer will redo the calculations.
Auto Sum Function

Paste Function

You have all the
features of a word
processing application. Use color, change your font and size, and add borders.

Excel Attendance Spreadsheet
Following the worksheet below, enter a list of your students in column A. Create
a weekly listing with days of the week and set up formulas for calculating totals
days attended, by each student, at the end of the month using the sum function.
Do the same for each month of the fall. You could put the months under each
other or continue along the spreadsheet. In December you may create a total for
all of the fall months. Using the same form but changing the dates you will be
able to create a winter attendance spreadsheet in Sheet 2. It is just a matter of
copy and paste.
To make it easier to view the names
and dates, highlight the columns you
have completed.
On the Format menu select Hide. The
rows you previously worked with will
disappear.
To display them at a later date
Highlight the columns to the right and
to the left of the columns you have
hidden, on the Format menu, select
Unhide. The columns, once hidden,
will reappear.

To Duplicate any formulas you may create in this workbook, use the Fill Handle.
Select the cell in which you created a formula, place the cursor on the tip of the
lower right edge and drag to the remaining cells where you want the same
mathematical operation performed. Excel will fill in the new cell range
automatically.
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Excel Budget Spreadsheets
However, it is not always necessary to create your own spreadsheet from
scratch. On the Microsoft website they make available to their users many
excellent spreadsheets for you to personalize.
Personal Budget

To assist you in developing an
excel monthly or yearly personal
budget spreadsheet, go to
Microsoft Office and look under
Templates.
http://office.microsoft.com/enus/templates/default.aspx
Monthly Budget

Here are two that I downloaded
and can now revamp to fit my
needs. All formulas have been
inserted and will change
automatically as I rework the
spreadsheet.

If you are able to, download one of the worksheets and begin to work to rework it
to suit your needs. Copies are found on the CD you have been given as well.

12

Basic Computer Maintenance
When you buy a car, you do not expect it to work well if you do not do regular
maintenance. The same is true for the computer. There are many guides
available to give you the complete story. I will try to recap the best practices as I
see it.
•

Keep your computer system clean.
Use a can of compressed air to blow out the dust from your
computer and remove all dust from the cords and computer station.
Do not spray cleaner directly on your monitor screen. Put cleaner
on a soft cloth and wipe the monitor.

•

Use a surge protector or UPS
If possible you might want to invest in an UPS, uninterruptible
power supply. These may be purchased for about $50.00 at a local
computer store. It will protect your computer from electrical
charges, which may destroy your system’s hard drive. Some
believe that it will extend your computer’s lifespan by giving it
consistent power every day.

•

Never turn the computer off with the power switch.
Always try to use the Shut Down button in the Start menu. If this is
unavailable because of computer problems, press the Clt. + Alt +
Del keys at the same time and this will allow you to close down
programs which may be causing trouble. Pressing these keys
again will reboot your computer.
However, if your computer is locked up and your hard drive is not
running, you may be forced to turn it off using the power source.

•

Clean files
It is important to take care of a computer on the inside, in the same
way that you cleaned the outside.
Go to: Start> Programs> Accessories> System Tools> Cleanup
Select the drive you want cleaned.
When the program is finished it will give you a choice of what to
remove. I always allow it to remove Downloaded programs, which I
have installed, Temporary Internet Files, Recycle Bin and
Temporary Files.
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•

Clean up your Start Menu
Start >Run> type msconfig press enter. Select Startup from the
folders.
Now you are ready to remove unwanted programs from running as
soon as the computer is turned on. This takes up valuable space.
However, do not delete anything with which you are unfamiliar.
Play it safe. Research it first on Google or send a question to the
list on Tech Support Guy at http://www.techsupportguy.com/. They
offer free computer support to users of all levels and they send out
a monthly newsletter with good tips and advice.

•

Run Cleanup and Defragmenter
Over time your hard disk can become fragmented, with parts of the
same disk file scattered over different areas of the disk. Defragging
rearranges the storage of files so that the computer runs faster and
more efficiently. Cleanup clears the hard drive of unnecessary files
in order to free disc space. Both can be found under the system
tools. Schedule these for regular use to keep your hard disk drive
running well.
Start> Programs> Accessories> System Tools
Select the drives you want to clean and defrag. Schedule these
tasks by using the Schedule Tasks Wizard, which is also found
under System Tools.
You are able to select the program you want
to run and the date and time you want it to
begin. If the program you want is not listed,
use the browse button to find it on your
system.
You should set up a maintenance schedule to
run on a regular basis to keep your hard drive
running smoothly.
When you turn your computer on, your virus
checker should be set to run.
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•

Scan for Viruses, Spyware and AdAware
Spyware and adaware are software applications that gather
information through your Internet connection, most often for
advertising and send it back to someone. Some adware is
harmless but when it invades your privacy it becomes spyware,
which can also gather information from your email, passwords and
credit cards.
They often come bundled with freeware and shareware. However,
not all freeware and shareware have them attached. A Virus, on
the other hand is a malicious program that can cause serious
damage to your computer.
To remove these nasty programs, it is necessary to purchase or
download and run programs that will destroy them. These
programs can be downloaded for free from the Internet and you
should use them often to free your computer of these problems.
Remember to keep them effective they should be updated on a
regular basis.

For more maintenance tips, go to the Advancing Learning
Technology Website:
Free and Inexpensive Softwarehttp://alt.ns.literacy.ca/mod/resource/view.php?id=76
Computer Maintenance http://alt.ns.literacy.ca/mod/resource/view.php?id=62
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Online Learning – Sources of Information
For our purposes, we will define online learning as learning, which takes place
through the Internet and is known as web-based.
Computer Learning
URL
http://www.gcflearnfree.org/

Name of Site
Global Learning – Site for free
computer learning
http://www.bbc.co.uk/computertutor/computertuto BBC Computer Tutor
rone/index.shtml
http://www.fayette.k12.il.us/99/Intro2Comp/introd Introduction to Computers
uction_to_computers.html
http://www.sense-lang.org/typing/
Touch Typing
http://www.geocities.com/tmbzone_cfb/index.htm Geocities Computers for Beginners

Microsoft Programs Tutorials
URL
http://www.baycongroup.com/
http://www.firstfind.info/

Name of Site
Free Online Tutorials
Look under ‘Computers and
Technology’
http://dragon.ep.usm.edu/~it365/module/index.html MSIT Tutorials
http://www.gcflearnfree.org/
Global Learning – Site for free
Microsoft Tutorials
Internet Search Tutorials:
URL
http://www.learnthenet.com/english/index.html
http://www.lib.berkeley.edu/TeachingLib/Guides
/Internet/SearchEngines.html
http://www.learnwebskills.com/search/main.html
http://www.sc.edu/beaufort/library/pages/bones/
bones.shtml

Name of Site
Learn the Net
The Best Search Engines
Web Search Strategies
Barebones 101 Tutorial

Literacy Instruction:
URL
http://www.tv411.org/index.shtml

Name of Site
TV411 – look under the ‘Improve
your… ‘
http://web2.uvcs.uvic.ca/elc/studyzone/index.htm English Language Centre Study Zone
http://literacynet.org/cnnsf/archives.html
Learning Resources
http://www.bbc.co.uk/skillswise/
Skillswise
http://home.comcast.net/~djrosen/software.html Adult Literacy Education Software
Recommendations
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Professional Development:
URL
http://www.nald.ca
http://wiki.literacytent.org/index.php/
Adult_Literacy_Professional_Develo
pment
http://www.otan.us/
http://adultedonline.org
http://www.cdlponline.org/

National Adult Literacy Database
Adult Literacy Professional Development

Outreach and Technical Assistance Network for
Adult Educators
Adult Education Online
Adult Learning

Checking Validity and Security of Website:
URL
http://www.library.cornell.edu/olinuri Five Criteria for Evaluating WebPages
s/ref/webcrit.html
http://www.lib.berkeley.edu/Teachin Evaluating WebPages
gLib/Guides/Internet/Evaluate.html
http://www.library.jhu.edu/researchh Evaluating Information Found on the Internet
elp/general/evaluating/#a
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